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MS Excel:Spreadsheets and their uses in Business,Excel 
basics,Rearranging Worksheets, Excel Formatting 
techniques,Using Formulas and Functions. 

 

Introduction to Microsoft Excel 
There are numbers of spreadsheet programs but from all of them, Excel is 
most widely used. People have been using it for last 30 years and 
throughout these years, it has been upgraded with more and more features. 

The best part about Excel is, it can apply to many business tasks, including 
statistics, finance, data management, forecasting, analysis, inventory, 
billing, and business intelligence. 

Following are the few things which it can do for you: 

• Number Crunching 
• Charts and Graphs 
• Store and Import Data 
• Manipulating Text 
• Templates/Dashboards 
• Automation of Tasks 
• And Much More... 
Three most important components of Excel is which you need to understand 
first: 

1. Cell: A cell is a smallest but most powerful part of a spreadsheet. You 
can enter your data into a cell either by typing or by copy-paste. Data can 
be a text, a number, or a date. You can also customize it by changing its 
size, font color, background color, borders, etc. Every cell is identified by 
its cell address, cell address contains its column number and row number 
(If a cell is on 11th row and on column AB, then its address will be AB11). 

2. Worksheet: A worksheet is made up of individual cells which can 
contain a value, a formula, or text. It also has an invisible draw layer, 



which holds charts, images, and diagrams. Each worksheet in a workbook 
is accessible by clicking the tab at the bottom of the workbook window. In 
addition, a workbook can store chart sheets; a chart sheet displays a 
single chart and is accessible by clicking a tab. 

3. Workbook: A workbook is a separate file just like every other 
application has. Each workbook contains one or more worksheets. You can 
also say that a workbook is a collection of multiple worksheets or can be a 
single worksheet. You can add or delete worksheets, hide them within the 
workbook without deleting them, and change the order of your 
worksheets within the workbook. 

Microsoft Excel Window Components 
Before you start using it, it’s really important to understand that what’s 
where in its window. So ahead we have all the major component which you 
need to know before entering the world of Microsoft Excel. 

1. Active Cell: A cell which is currently selected. It will be highlighted by 
a rectangular box and its address will be shown in the address bar. You 
can activate a cell by clicking on it or by using your arrow buttons. To edit 
a cell, you double-click on it or use F2 to as well. 



2. Columns: A column is a vertical set of cells. A single worksheet 
contains 16384 total columns. Every column has its own alphabet for 
identity, from A to XFD. You can select a column clicking on its header. 

3. Rows: A row is a horizontal set of cells. A single worksheet contains 
1048576 total rows. Every row has its own number for identity, starting 
from 1 to 1048576. You can select a row clicking on the row number 
marked on the left side of the window. 

4. Fill Handle: It’s a small dot present on the lower right corner of the 
active cell. It helps you to fill numeric values, text series, insert ranges, 
insert serial numbers, etc. 

5. Address Bar: It shows the address of the active cell. If you have 
selected more than one cell, then it will show the address of the first cell 
in the range. 

6. Formula Bar: The formula bar is an input bar, below the ribbon. It 
shows the content of the active cell and you can also use it to enter a 
formula in a cell. 

7. Title Bar: The title bar will show the name of your workbook, followed 
by the application name (“Microsoft Excel”). 

8. File Menu: The file menu is a simple menu like all other applications. 
It contains options like (Save, Save As, Open, New, Print, Excel Options, 
Share, etc). 

9. Quick Access Toolbar: A toolbar to quickly access the options which 
you frequently use. You can add your favorite options by adding new 
options to quick access toolbar. 

10. Ribbon Tab: Starting from the Microsoft Excel 2007, all the options 
menus are replaced with the ribbons. Ribbon tabs are the bunch of 
specific option group which further contains the option. 

11. Worksheet Tab: This tab shows all the worksheets which are present 
in the workbook. By default you will see, three worksheets in your new 
workbook with the name of Sheet1, Sheet2, Sheet3 respectively. 

12. Status Bar: It is a thin bar at the bottom of the Excel window. It will 
give you an instant help once you start working in Excel. 

Microsoft Excel Basic Functions 
Functions are one of the most important features of Excel. It helps you to perform the basic 
calculations as well complex. Below I have listed 10 Basic Excel Functions which 
you need to learn. 
1. SUM: It returns the sum of numeric values in a cell. You can refer to 

the cells where you have values or simply insert the values into the 
function [...] 

2. COUNT: It returns the count of numeric values in a cell. You can refer 
to the cells where you have values or simply insert the values into the 
function [...] 



3. AVERAGE: It returns the average of numeric values in a cell. You can 
refer to the cells where you have values or simply insert the values into 
the function [...] 

4. TIME: It returns a valid time serial number as per Excel's time format. 
You need to specify hours, minutes and seconds [...] 

5. DATE: It returns a valid date serial number as per Excel's time format. 
You need to specify day, month and year [...] 

6. LEFT: This function extracts specific characters from the a cell/string 
starting from the left (start). You need to specify the text and number of 
characters to extract [...] 

7. RIGHT: This function extracts specific characters from the a cell/string 
starting from the right (last). You need to specify the text and number of 
characters to extract [...] 

8. VLOOKUP: It looks up for a value in a column and can return that 
value or a value from the correspondent columns using same row number 
[...] 

9. IF: This function returns a value when the specific condition is TRUE 
and returns another values it condition is FALSE [...] 

10. NOW: It returns the current date and time in the cell where you insert 
it using your system's settings [...] 

Basic Terms in Excel 

There are two basic ways to perform calculations in Excel: Formulas and 
Functions. 

  

1. Formulas 
In Excel, a formula is an expression that operates on values in a range of cells 
or a cell. For example, =A1+A2+A3, which finds the sum of the range of values 
from cell A1 to cell A3. 

2. Functions 
Functions are predefined formulas in Excel. They eliminate laborious manual 
entry of formulas while giving them human-friendly names. For example: 
=SUM(A1:A3). The function sums all the values from A1 to A3. 

  



Five Time-saving Ways to Insert Data into Excel 
When analyzing data, there are five common ways of inserting basic Excel 
formulas. Each strategy comes with its own advantages. Therefore, before 
diving further into the main formulas, we’ll clarify those methods, so you can 
create your preferred workflow earlier on. 

  

1. Simple insertion: Typing a formula inside the cell 
Typing a formula in a cell or the formula bar is the most straightforward 
method of inserting basic Excel formulas. The process usually starts by typing 
an equal sign, followed by the name of an Excel function. 

Excel is quite intelligent in that when you start typing the name of the 
function, a pop-up function hint will show. It’s from this list you’ll select your 
preference. However, don’t press the Enter key. Instead, press the Tab key so 
that you can continue to insert other options. Otherwise, you may find 
yourself with an invalid name error, often as ‘#NAME?’. To fix it, just re-select 
the cell, and go to the formula bar to complete your function. 
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2. Using Insert Function Option from Formulas Tab 
If you want full control of your functions insertion, using the Excel Insert 
Function dialogue box is all you ever need. To achieve this, go to the Formulas 
tab and select the first menu labeled Insert Function. The dialogue box will 
contain all the functions you need to complete your financial analysis. 



  

  

3. Selecting a Formula from One of the Groups in Formula Tab 
This option is for those who want to delve into their favorite functions quickly. 
To find this menu, navigate to the Formulas tab and select your preferred 
group. Click to show a sub-menu filled with a list of functions. From there, you 
can select your preference. However, if you find your preferred group is not on 
the tab, click on the More Functions option – it’s probably just hidden there. 
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4. Using AutoSum Option 
For quick and everyday tasks, the AutoSum function is your go-to option. So, 
navigate to the Home tab, in the far-right corner, and click the AutoSum 
option. Then click the caret to show other hidden formulas. This option is also 
available in the Formulas tab first option after the Insert Function option. 

  

  

  

5. Quick Insert: Use Recently Used Tabs 
If you find re-typing your most recent formula a monotonous task, then use 
the Recently Used menu. It’s on the Formulas tab, a third menu option just 
next to AutoSum. 

  



  

  



Free Excel Formulas YouTube Tutorial 
Watch CFI’s FREE YouTube video tutorial to quickly learn the most important 
Excel formulas. By watching the video demonstration you’ll quickly learn the 
most important formulas and functions. 

  

  

Seven Basic Excel Formulas For Your Workflow 
Since you’re now able to insert your preferred formulas and function correctly, 
let’s check some fundamental Excel functions to get you started. 

  

1. SUM 
The SUM function is the first must-know formula in Excel. It usually aggregates 
values from a selection of columns or rows from your selected range. 

=SUM(number1, [number2], …) 

  

Example: 

=SUM(B2:G2) – A simple selection that sums the values of a row. 

=SUM(A2:A8) – A simple selection that sums the values of a column. 

=SUM(A2:A7, A9, A12:A15) – A sophisticated collection that sums values 
from range A2 to A7, skips A8, adds A9, jumps A10 and A11, then finally adds 
from A12 to A15. 

=SUM(A2:A8)/20 – Shows you can also turn your function into a formula. 
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2. AVERAGE 
The AVERAGE function should remind you of simple averages of data such as 
the average number of shareholders in a given shareholding pool. 

=AVERAGE(number1, [number2], …) 

  

Example: 

=AVERAGE(B2:B11) – Shows a simple average, also similar to 
(SUM(B2:B11)/10) 

  

  



 

  

3. COUNT 
The COUNT function counts all cells in a given range that contain only 
numeric values. 

=COUNT(value1, [value2], …) 



  

Example: 

COUNT(A:A) – Counts all values that are numerical in A column. However, you 
must adjust the range inside the formula to count rows. 

COUNT(A1:C1) – Now it can count rows. 
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4. COUNTA 
Like the COUNT function, COUNTA counts all cells in a given rage. However, it 
counts all cells regardless of type. That is, unlike COUNT that only counts 
numerics, it also counts dates, times, strings, logical values, errors, empty 
string, or text. 

=COUNTA(value1, [value2], …) 

  

Example: 

COUNTA(C2:C13) – Counts rows 2 to 13 in column C regardless of type. 
However, like COUNT, you can’t use the same formula to count rows. You 
must make an adjustment to the selection inside the brackets – for 
example, COUNTA(C2:H2) will count columns C to H 

  



 

  



5. IF 
The IF function is often used when you want to sort your data according to a 
given logic. The best part of the IF formula is that you can embed formulas 
and function in it. 

=IF(logical_test, [value_if_true], [value_if_false]) 

  

Example: 

=IF(C2<D3, ‘TRUE,’ ‘FALSE’) – Checks if the value at C3 is less than the value 
at D3. If the logic is true, let the cell value be TRUE, else, FALSE 

  

=IF(SUM(C1:C10) > SUM(D1:D10), SUM(C1:C10), SUM(D1:D10)) – An 
example of a complex IF logic. First, it sums C1 to C10 and D1 to D10, then it 
compares the sum. If the sum of C1 to C10 is greater than the sum of D1 to 
D10, then it makes the value of a cell equal to the sum of C1 to C10. 
Otherwise, it makes it the SUM of C1 to C10. 

  



  

6. TRIM 
The TRIM function makes sure your functions do not return errors due to 
unruly spaces. It ensures that all empty spaces are eliminated. Unlike other 
functions that can operate on a range of cells, TRIM only operates on a single 
cell. Therefore, it comes with the downside of adding duplicated data in your 
spreadsheet. 



=TRIM(text) 

  

Example: 

TRIM(A2) – Removes empty spaces in the value in cell A2. 
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7. MAX & MIN 
The MAX and MIN functions help in finding the maximum number and the 
minimum number in a range of values. 

=MIN(number1, [number2], …) 

  

Example: 

=MIN(B2:C11) – Finds the minimum number between column B from B2 and 
column C from C2 to row 11 in both columns B and C. 

  

=MAX(number1, [number2], …) 

  

Example: 

=MAX(B2:C11) – Similarly, it finds the maximum number between column B 
from B2 and column C from C2 to row 11 in both columns B and C. 

  



 

  

  



 

  

 

Microsoft Excel Basic Tutorials 
Below I have listed some of the most important Basic Microsoft Excel 
tutorials which can be helpful for you in day-to-day work. 



1. Add Serial Numbers in Excel: These methods can generate numbers up 
to a specific number or can add a running column of numbers [...] 

2. Bullet Points in Excel: Unlike Word, in Excel, there is no default option 
to insert bullet points. But there are total [...] 

3. Strikethrough in Excel: When it comes to Excel, we don’t have any 
direct option to apply strikethrough to a cell. No button or an option [...] 

4. Formula to Value: All the methods which I've shared here are different 
in nature and you can use them according to [...] 

5. Fill Justify in Excel: The single core motive to use fill justify in excel is 
to merge the data from multiple cells into a single cell [...] 

6. Generate Barcode in Excel: But here is the good news: You can 
generate a bar-code in Excel by installing a font [...] 

7. Select Non-Adjacent Cells in Excel: Normally, when you need to select 
multiple cells which are not continuing, you press [...] 

8. Format Painter: Format Painter is a simple and effective tool to apply 
formatting from one cell to another cell. For Example [...] 

9. Check Mark in Excel: Eventually today morning, I thought maybe there 
is more than one way to add a check mark [...] 

10. Insert Timestamp in Excel: And, quickly I realized that she was talking 
about a timestamp. I’m sure you also use it while working in Excel [...] 

11. Sort Horizontally in Excel: Have you ever wondered that you can 
horizontally sort data in Excel? I mean, you can sort [...] 

What is Microsoft Excel? 
Microsoft Excel is a spreadsheet program that is used to record and analyse 
numerical data. Think of a spreadsheet as a collection of columns and rows 
that form a table. Alphabetical letters are usually assigned to columns and 
numbers are usually assigned to rows. The point where a column and a row 
meet is called a cell. The address of a cell is given by the letter representing 
the column and the number representing a row. Let's illustrate this using the 
following image. 

Why Should I Learn Microsoft Excel? 

We all deal with numbers in one way or the other. We all have daily expenses 
which we pay for from the monthly income that we earn. For one to spend 
wisely, they will need to know their income vs. expenditure. Microsoft Excel 
comes in handy when we want to record, analyze and store such numeric 
data. 



 

Where can I get Microsoft Excel? 

There are number of ways in which you can get Microsoft Excel. You can buy 
it from a hardware computer shop that also sells software. Microsoft Excel is 
part of the Microsoft Office suite of programs. Alternatively, you can download 
it from the Microsoft website but you will have to buy the license key. 

In this tutorial, we are going to cover the following topics. 

• How to Open Microsoft Excel? 
• Understanding the Ribbon 
• Understanding the worksheet 
• Customization Microsoft Excel Environment 
• Important Excel shortcuts 

How to Open Microsoft Excel? 
Running Excel is not different from running any other Windows program. If 
you are running Windows with a GUI like (Windows XP, Vista, and 7) follow 
the following steps. 

• Click on start menu 



• Point to all programs 
• Point to Microsoft Excel 
• Click on Microsoft Excel 

Alternatively, you can also open it from the start menu if it has been added 
there. You can also open it from the desktop shortcut if you have created one. 

For this tutorial, we will be working with Windows 8.1 and Microsoft Excel 
2013. Follow the following steps to run Excel on Windows 8.1 

• Click on start menu 
• Search for Excel N.B. even before you even typing, all programs 

starting with what you have typed will be listed. 
• Click on Microsoft Excel 

The following image shows you how to do this 

 

Understanding the Ribbon 
The ribbon provides shortcuts to commands in Excel. A command is an action 
that the user performs. An example of a command is creating a new 
document, printing a documenting, etc. The image below shows the ribbon 
used in Excel 2013. 



 

Ribbon components explained 

Ribbon start button - it is used to access commands i.e. creating new 
documents, saving existing work, printing, accessing the options for 
customizing Excel, etc. 

Ribbon tabs – the tabs are used to group similar commands together. The 
home tab is used for basic commands such as formatting the data to make it 
more presentable, sorting and finding specific data within the spreadsheet. 

Ribbon bar – the bars are used to group similar commands together. As an 
example, the Alignment ribbon bar is used to group all the commands that are 
used to align data together. 

Understanding the worksheet (Rows and 
Columns, Sheets, Workbooks) 
A worksheet is a collection of rows and columns. When a row and a 
column meet, they form a cell. Cells are used to record data. Each cell is 
uniquely identified using a cell address. Columns are usually labelled with 
letters while rows are usually numbers. 

A workbook is a collection of worksheets. By default, a workbook has 
three cells in Excel. You can delete or add more sheets to suit your 
requirements. By default, the sheets are named Sheet1, Sheet2 and so on 



and so forth. You can rename the sheet names to more meaningful names i.e. 
Daily Expenses, Monthly Budget, etc. 

 

Customization Microsoft Excel Environment 
Personally I like the black colour, so my excel theme looks blackish. Your 
favourite colour could be blue, and you too can make your theme colour look 
blue-like. If you are not a programmer, you may not want to include ribbon 
tabs i.e. developer. All this is made possible via customizations. In this sub-
section, we are going to look at; 

• Customization the ribbon 
• Setting the colour theme 
• Settings for formulas 
• Proofing settings 
• Save settings 

Customization of ribbon 

 

The above image shows the default ribbon in Excel 2013. Let's start with 
customization the ribbon, suppose you do not wish to see some of the tabs on 



the ribbon, or you would like to add some tabs that are missing such as the 
developer tab. You can use the options window to achieve this. 

• Click on the ribbon start button 
• Select options from the drop down menu. You should be able to see an 

Excel Options dialog window 
• Select the customize ribbon option from the left-hand side panel as 

shown below 

 

• On your right-hand side, remove the check marks from the tabs that you 
do not wish to see on the ribbon. For this example, we have removed 
Page Layout, Review, and View tab. 

• Click on the "OK" button when you are done. 

Your ribbon will look as follows 



 

Adding custom tabs to the ribbon 

You can also add your own tab, give it a custom name and assign commands 
to it. Let's add a tab to the ribbon with the text Guru99 

 

1. Right click on the ribbon and select Customize the Ribbon. The dialogue 
window shown above will appear 

2. Click on new tab button as illustrated in the animated image below 



3. Select the newly created tab 
4. Click on Rename button 
5. Give it a name of Guru99 
6. Select the New Group (Custom) under Guru99 tab as shown in the 

image below 
7. Click on Rename button and give it a name of My Commands 
8. Let's now add commands to my ribbon bar 
9. The commands are listed on the middle panel 
10. Select All chart types command and click on Add button 
11. Click on OK 

Your ribbon will look as follows 

 

Setting the colour theme 

To set the color-theme for your Excel sheet you have to go to Excel ribbon, 
and click on à File àOption command. It will open a window where you have to 
follow the following steps. 



 

1. The general tab on the left-hand panel will be selected by default. 
2. Look for colour scheme under General options for working with Excel 
3. Click on the colour scheme drop-down list and select the desired colour 
4. Click on OK button 

Settings for formulas 

This option allows you to define how Excel behaves when you are 
working with formulas. You can use it to set options i.e. autocomplete when 
entering formulas, change the cell referencing style and use numbers for both 
columns and rows and other options. 



 

If you want to activate an option, click on its check box. If you want to 
deactivate an option, remove the mark from the checkbox. You can this option 
from the Options dialogue window under formulas tab from the left-hand side 
panel 



Proofing settings 

 

This option manipulates the entered text entered into excel. It allows 
setting options such as the dictionary language that should be used when 
checking for wrong spellings, suggestions from the dictionary, etc. You can 
this option from the options dialogue window under the proofing tab from the 
left-hand side panel 



Save settings 

 

This option allows you to define the default file format when saving files, 
enable auto recovery in case your computer goes off before you could 
save your work, etc. You can use this option from the Options dialogue 
window under save tab from the left-hand side panel 

Important Excel shortcuts 

Ctrl + P  used to open the print dialogue window 

Ctrl + N  creates a new workbook 



Ctrl + S  saves the current workbook 

Ctrl + C  copy contents of current select 

Ctrl + V  paste data from the clipboard 

SHIFT + F3  displays the function insert dialog window 

SHIFT + F11  Creates a new worksheet 

F2  Check formula and cell range covered 

Best Practices when working with Microsoft Excel 
1. Save workbooks with backward compatibility in mind. If you are not 

using the latest features in higher versions of Excel, you should save 
your files in 2003 *.xls format for backwards compatibility 

2. Use description names for columns and worksheets in a workbook 
3. Avoid working with complex formulas with many variables. Try to 

break them down into small managed results that you can use to build 
on 

4. Use built-in functions whenever you can instead of writing your 
own formulas 

Summary 
• Microsoft Excel is a powerful spreadsheet program used to record, 

manipulate, store numeric data and it can be customized to match your 
preferences 

• The ribbon is used to access various commands in Excel 
• The options dialogue window allows you to customize a number of 

items i.e. the ribbon, formulas, proofing, save, etc. 

 


